
 

 

Ear Training Tip:  

Inserting A Free Spectrum Analyzer Plugin 

Across All Computer Audio 

 

Make the most of time spent at the computer with an ‘always on’ spectrum analyzer 

across all audio: local music files, audio or video streams, CDs, DVDs, movies… Everything. 
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Background  

Listening With Your Eyes  

In both live and studio settings, a spectrum analyzer is a valuable tool for gauging the tonal balance of a 

mix. Like putting a face to a name (in this case, Frequency, Amplitude, and Time), spectrum analyzers can 

help you see what a mix or environment is doing – or what it can do better.  

 

Analyzers can also be a great tool for training your ears with prerecorded material. They can help you get 

familiar with the frequency range of different instruments and voices (including their harmonics), or help 

you put your finger on the sonic signature of a particular artist, genre, style, era, or format (music, film, TV, 

radio, etc.).  

 

 
 

Screenshot of Voxengo's SPAN plugin. 

 

The Old Way (And Not Always Practical 'New Ways')  

Unless you had a dedicated hardware analyzer, studying prerecorded audio from a computer was a 

somewhat tedious process. Often, it meant ripping and/or converting audio, importing to a DAW or 

editor, slapping an analyzer plugin across the output, and, finally, studying the results. 

 

Even if this approach worked for local media, what if most of your listening happens via streaming, or 

while you're busy doing other things? 
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While you can now use a smartphone or tablet as an analyzer, this too involves extra steps and 

connections. You may also need extra hardware for the results to be meaningful, like an external audio 

interface or a quality measurement mic (and an understanding of your room’s acoustics). And you may not 

always have these on hand.  

 

For the extra geeky, there are even a small handful of media players that support addons (known as 

"wrappers") to incorporate pro audio-caliber plugins. But again, this means extra steps and going outside 

of your normal routine (read: less likely to bother). And it still doesn’t help for streaming services that 

don’t support external players. 

 

How This In-The-Box Setup Works  

Learn While You Work (Or Play)  

This guide will show you how to insert a totally in-the-box – and free – spectrum analyzer across all 

computer audio, regardless of the source (local files, audio or video streams, a CD or DVD). This way, you 

can glance at an analyzer any time you hear something interesting, regardless of whether you're actively 

listening, working, or surfing the web – no matter where you are. 

 

It's also a great way to get a better approximation of what's really happening when your playback system 

or environment is less than optimal (poor laptop speakers, low-quality earbuds or headphones, an 

especially bad room). 

 

 
 

Keeping up with SoundGirls.org on a laptop while listening to music and analyzing audio. 

 

http://www.soundgirls.org/home
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About The Tools & How They Work Together  

The tools described in this guide will form a virtual patchbay between the audio source (any program 

playing audio on your computer) and your playback system (your preferred soundcard, speakers, and 

headphones). 

 

One-time setup involves installing and configuring 3 basic components:  

1. A virtual audio device, to intercept all computer audio before your soundcard. 

2. A spectrum analyzer plugin. 

3. A plugin host, a simple piece of software to receive the audio from the virtual audio device, pass it 

through the analyzer plugin, and finally pass it back to your sound card, headphones, and/or 

speakers, all with minimal latency.  

Once your system and software are configured, you can leave things 'always on,' or you can easily switch 

between your analyzer setup and your normal setup with just a few clicks. 

 

How Long Does This All Take?  

About 10 minutes from setup start to finish. Even the downloads are modestly-sized.  

About The System And Tools Used Here  

While this guide uses terminology and screenshots for a system running Windows 7 (64-bit), the same 

basic concepts apply to a Mac or other versions of Windows.  

 

The specific software tools used in the examples were chosen because they are free or donation-based, 

simple to use, and minimally-invasive (i.e., they're small, efficient, make minimal modifications to your 

system, don’t include any adware or bloat, and are easy to turn on or off). See the bottom of the 

Downloads section for a list of alternative tools for both Windows and Mac platforms.  

 

More Than A One-Trick Pony  

This guide focuses on getting you up and running with a single spectrum analyzer plugin. However, these 

tools allow you to run any type of plugin and create any effect chain you’d like. You can even run multiple 

analyzer and metering plugins side-by-side, each with its own settings. Or you can add effects 

(compressors, limiters, reverbs, delays, etc.).  For a glimpse of what's possible, see the section on taking 

things to the next level, towards the end of this guide. 
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Something else important to keep in mind: these thoughtfully-developed tools can be used for much, 

much more than just inserting plugins. Learning more about each program's features and exploring their 

full sonic and music-making potential is highly recommended. Be sure to check out the developers' sites 

and help resources (referenced throughout this guide). 

 

Already A PC Audio Pro?  

If you're already familiar with tweaking computers for audio, downloading the three main components 

may be all you need to get on your way. For the rest, continue reading and we'll cover all the bases. 

 

Let’s get started.  
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Downloads  

First, we'll gather all of the necessary components. Installation and setup will be addressed in later steps.  

 

IMPORTANT REMINDER: These free or donation-based tools are intended for non-commercial use. Do right by 

their creators and honor this privilege. Also, if you keep these tools installed and use them, remember to show 

your thanks and support by donating to the developers. Links are included below. 

 

Virtual Audio Device  

In this guide, we'll use VB-Audio's VB-Cable  for Windows.  

Direct download (Windows): 

http://vbaudio.jcedeveloppement.com/Download_CABLE/VBCABLEDriver_Pack42b.zip 

 

Product info and donations: 

http://vb-audio.pagesperso-orange.fr/Cable/index.htm 

 

Spectrum Analyzer Plugin  

Here we'll use the VST version of Voxengo's SPAN plugin (free edition).  

Direct download (Windows): 

http://www.voxengo.com/files/VoxengoSPAN_29_Win32_64_VST_VST3_setup.exe 

 

Product info and links to Mac version: 

http://www.voxengo.com/product/span/ 

 

Plugin Host  

We'll be using Niall Moody's Pedalboard2 for Windows.   

Direct download (Windows): 

http://downloads.niallmoody.com/Pedalboard2-2.14-windows.zip 

 

Product info, donations, and links to Mac version: 

http://www.niallmoody.com/apps/pedalboard2 

 

http://vbaudio.jcedeveloppement.com/Download_CABLE/VBCABLEDriver_Pack42b.zip
http://vb-audio.pagesperso-orange.fr/Cable/index.htm
http://www.voxengo.com/files/VoxengoSPAN_29_Win32_64_VST_VST3_setup.exe
http://www.voxengo.com/product/span/
http://downloads.niallmoody.com/Pedalboard2-2.14-windows.zip
http://www.niallmoody.com/apps/pedalboard2
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Software Alternatives (Mac & Windows)  

The table below (by no means exhaustive) contains a brief list of alternatives for both Mac and Windows 

systems, including those used in this guide (referenced above). Click the software name to visit the 

developer or project website. 

 

If you use the software, don't forget to donate (where applicable). Also be sure to check out their other 

products.  

 

Virtual Audio Devices Mac Windows Cost 

VB-Cable (VB-Audio)    Free / Donation 

JACK Audio Connection Kit   Free 

Soundflower (Rogue Amoeba)   Free 

Virtual Audio Cable (VAC) (Eugene Muzychenko)   $25 - $50 (free demo) 

Sound Siphon (Static Z)   $29.99 (free demo) 

WireTap Anywhere (Ambrosia Software)    $129 (free trial) 

Plugin Hosts 

Pedalboard2 (Niall Moody)   Free / Donation 

VSTHost (Hermann Seib)   Free / Donation 

Carla (KSStudio)   Free / Donation 

Plugins 

SPAN (free edition) (Voxengo)   Free 

AnSpec (Voxengo)   Free 

FreqAnalyst (Blue Cat)   Free 

T-RackS CS Metering (IK Multimedia)   Free 

virtual studio (beyerdynamic)   Free 
 

 

http://vb-audio.pagesperso-orange.fr/Cable/index.htm
http://jackaudio.org/
https://rogueamoeba.com/freebies/soundflower/
http://software.muzychenko.net/eng/vac.htm
http://staticz.com/soundsiphon/
http://www.ambrosiasw.com/utilities/wta/
http://www.niallmoody.com/apps/pedalboard2
http://www.hermannseib.com/english/vsthost.htm
http://kxstudio.sourceforge.net/Applications:Carla
http://www.voxengo.com/product/span/
http://www.voxengo.com/product/anspec/
http://www.bluecataudio.com/Products/Product_FreqAnalyst/
http://www.ikmultimedia.com/products/trmetering/
http://beyerdynamic.com/virtual-studio.html
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Step 1: Setting Up A Virtual Audio Device  

A virtual audio device like VB-Cable will allow you to intercept your computer's audio before it reaches 

your preferred sound card. 

 

Installing The Virtual Audio Device  

1. Be sure you are logged-in to Windows as a user with Administrator rights. 

Tip: Not sure if you're an Administrator? Go 

to Control Panel\All Control Panel 

Items\User Accounts\Manage Accounts. 

Beneath your username, it should say 

"Administrator." 

 

2. Locate the zip file you downloaded for 

VB-Cable. 
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3. Extract the zip file to your desktop or another 

temporary location. 

4. In the extracted folder, run the correct setup file 

for your version of Windows. 

 

For 64-bit Windows, run VBCABLE_Setup_x64. 

  

For 32-bit Windows, run VBCABLE_Setup. 

 

 

 

 

 

 

 

 
 

Tip: Not sure if your version of 

Windows is 32-bit or 64-bit? 

Go to Control Panel\All Control Panel 

Items\System. Look for the entry 

System Type to confirm your version. 

In this example, the system is 64-bit: 

 

5. Follow the prompts to install the driver.  

 

During installation the program may 

show as "not responding" for a few 

seconds. This is normal -- just wait for the 

dialog box confirming the installation has 

finished. A reboot of your system is 

recommended after installation. 
 



Page 10 of 27 

 

Enabling The Virtual Audio Device  

Next you'll re-configure Windows to pass audio to the virtual audio device (instead of directly to your 

soundcard). 

 

1. Right-click the speaker icon in the notification area (bottom right of 

your taskbar) and click Playback Devices. A new window will open. 

 

2. In the Sounds window, in addition to your 

soundcard(s), you'll see a new device 

called CABLE Input, VB-Audio Virtual 

Cable.  

 

Right-click the device and choose Set as 

Default Device. 

 

Note: If you were already listening to audio when 

you make this change, your system will go silent. 

This is normal, until you finish re-routing the 

audio in the next steps. However, the meters to 

the right of the CABLE-Input device should 

reflect that an audio source is still playing back.      

 

3. Click OK to close the list of playback devices.  
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Step 2: Installing A Spectrum Analyzer Plugin  

1. Locate the installer you downloaded for 

Voxengo's SPAN plugin. 

 

2. Run the installer and follow the prompts to complete the installation. Unless you already use 

plugins and have a custom process for managing them, leave the default install options as-is (the 

installer will detect your system's bit depth and pre-select 32- or 64-bit versions of the SPAN, and 

uses industry-standard folders for the installation). 

 

No system restart is needed after installing SPAN. 
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Step 3: Setting Up A Plugin Host  

You'll setup the plugin host to receive audio from the virtual audio device, pass it through the analyzer 

plugin, and finally pass it back to your sound card.  

 

Installing The Plugin Host  

The plugin host we'll use, Pedalboard2, does not need to be installed in the traditional sense. It follows 

the "portable" software model, where you simply extract the program files to a folder, and launch the 

program from there. 

 

1. Locate the zip file you downloaded for 

Niall Moody's Pedalboard2. 

 

2. Extract the zip file to a folder where you want to keep the program, such as your desktop. 

Launching The Plugin Host For The First Time  

1. Open the extracted folder and launch the correct version 

of Pedalboard2 for your system. For a 64-bit system, use 

the version named Pedalboard2-64bit. For 32-bit, use the 

version named Pedalboard2. 
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2. When launching Pedalboard2 for the first time, 

you may receive a Windows Firewall prompt to 

grant Pedalboard2 network access. This is 

because Pedalboard2 has additional, network-

dependent features that are beyond the scope 

of this guide. If you plan to explore those 

features later, consider granting whichever 

level of network access you are comfortable 

with. If you deny all network access, the plugin 

features we'll be using here will still function 

correctly.    

 
 

Setting The Input And Output  

Next you'll configure Pedalboard2 to receive all computer audio from the virtual audio device, VB-Cable, 

and then hand off the audio to your preferred sound card (onboard, USB, etc.). 

 

1. In the Pedalboard2 app, go to Options > Audio Settings. A new 

window will open. 

 

 

 

2. Set the Audio Device dropdown to DirectSound. 

3. Set the output dropdown to your preferred soundcard. In the 

example to the right, the system will use Native Instruments’ 

Komplete Audio 6. 

4. Click the Test button to ensure that Pedalboard2 is sending 

audio to the soundcard you chose. You should here a short 

test tone. If you don’t, check your soundcard, volume 

controls, speakers, and/or headphones to ensure that all are 

connected, powered on, and working properly. 

5. Set the input dropdown to CABLE Output (VB-Audio Virtual 

Cable). 

6. Leave all other settings at their defaults. 
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7. Close the Audio Settings. 

Scanning Your System For Plugins  

Next you'll have Padalboard2 scan your system for plugins, including our spectrum analyzer, Voxengo's 

SPAN (any other plugins you may have installed previously will also be scanned): 

 

1. From the Pedalboard2 app, go to 

Options menu > Plugin List. A new 

window will open. 

 

2. The default list of Available Plugins will usually show 

only a handful of plugins that are included in 

Pedalboard2.  

 

If you don't see SPAN , click the Options button on 

the lower left, and choose Scan for new or updated 

VST plugins. A new window will open. 

 



Page 15 of 27 

3. In the new window, you’ll see the 

industry-standard location where 

Pedalboard2 will scan for plugins. The 

location you see depends on the version 

you are running (64-bit or 32-bit). The 

installer for our spectrum analyzer 

plugin, SPAN, follows the same 

industry-standard locations. So, unless 

you used custom locations during 

installation, you do not need to change 

the list of folders.  

 

If you did install SPAN into a custom 

location, click the "+" button to locate 

that folder and add it to the list. 

 

In the example on the right, we're using 

the 64-bit version of Pedalboard2, 

which by default correctly lists the 

standard location for 64-bit plugins. 

 

4. When you're finished verifying and/or adding 

plugin folders, click the Scan button to update the 

list of plugins. In the example on the right (taken 

from a DAW PC), Pedalboard2 is finding all 

installed plugins (not just our analyzer). 

 

Follow the prompts to finish the scanning process 

and return to Pedalboard2's main window. 
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Inserting A Spectrum Analyzer  

Now you're ready to insert the spectrum analyzer into the audio path.  

1. Double-click anywhere 

in the main window of 

Pedalboard2 to bring 

up the list of available 

plugins. 

 

In the example on the 

right, Pedalboard2 

shows a variety of 

plugins that were 

already installed on the 

PC.  

2. Choose SPAN from the list. This will add SPAN as a virtual device on the main window. You can 

move the devices around by simply dragging and dropping. 
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Finalizing The Plugin Chain And Completing The Signal Path  

Remember: We’ve already configuredVB-Cable (our virtual audio device) as the first stop for computer 

audio. We did this in both Windows (Sound settings) and Pedalboard2 (Audio Settings). We also 

configured Pedalboard2 to send its output to your preferred soundcard. 

 

Now we need to finish routing the audio insidePedalboard2. 

 

The way we’ll do this is by drawing virtual cables to connect the devices in Pedalboard’s main window. 

We’ll connect the Audio Input device, SPAN, and the Audio Output device. 

 

We’ll start with Pedalboard2’s Audio Input device (top left of the window).  

 

1. From the Audio Input device, click and hold the jack labeled 

Input 1, and draw a virtual cable to SPAN’s first input jack (on 

its left side). 

2. Repeat to connect Audio Input 2 to SPAN’s second input 

jack. 

 

3. In the same way, draw a cable from the 

SPAN ‘s first output jack (on its right 

side) to Output 1 on the Audio Output 

device (top right of the window). Repeat 

for the second output.  

 

We’re now done with our connections. 

 

Note: If you were playing back audio 

when you began setup, you may begin to 

hear it again as soon as you make the 

output connections. 
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4. Finally, click the e button on SPAN 

to open the plugin window. 

 

Note: If you were already playing 

audio, SPAN’s spectrum graph and 

meters will be in full effect. 

Otherwise, you will see no graph or 

meter activity until you start 

playback in the next steps. 

 

Your signal path is now ready for playback and tweaking the behavior of the spectrum analyzer to suit 

your needs and taste. 
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Testing Playback  

1. Launch any music player, video player, stream, CD, or DVD. 

 

Tip: To keep the audio from stopping while you get familiar with the new setup (or if you 

have to troubleshoot), choose a source that will provide uninterrupted audio for as long 

as possible (a reliable stream, a long playlist, an album, a long video, etc.).  

 

2. You should hear the audio immediately. If you don’t, go back to earlier steps and double-check 

your connections. 

 

3. Now go to the window for the SPAN plugin, which should be displaying the audio you’re playing.  

 

 

Congrats! You’re done with setup and ready to enjoy your new spectrum analyzer.  
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Basic Tweaks  

Tweaking SPAN  

SPAN is highly-configurable, from size and colors to metering types and scales, sensitivity, and speed. For 

help tweaking, consult the developer’s PDF user guides, located in the plugin install folder. 

 

For 64-bit versions, look for the Voxengo folder in C:\Program Files\Vstplugins 

 

For 32-bit versions, check C:\Program Files (x86)\VSTPlugins 

 

Tweaking Pedalboard2  

To automatically load your specific chain of plugins every 

time you start Pedalboard2, save them as your default 

preset by going to File > Save As Default. 

 

For additional help configuring and using Pedalboard2, as well as exploring everything else it can do, go 

to the program folder and see the subfolder named Documentation. 
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Turning Your Analyzer Setup Off And On  

Once you are finished with initial setup, switching your new audio path off or on is easy. You can also 

configure your system so that your analyzer setup automatically starts with Windows. 

 

Manual Off / On  

Since your setup is already ON, first we'll address turning it off.   

Turning your analyzer setup OFF involves just two steps: changing Windows to use your soundcard 

directly (i.e., re-enabling it, just as it was before), and quitting Pedalboard2.  

 

1. Right-click the speaker icon in the 

notification area (bottom right of your 

taskbar) and click Playback Devices. A 

new window will open. 

 

2. In the Sounds window, find your 

preferred soundcard, right-click, and 

choose Set as Default Device. 

 

Then click OK to close the list of 

playback devices. 

 

3. Got to Pedalboard2 and choose File > Exit.  

4. To turn your analyzer setup back on, just reverse the steps above, this time choosing VB-Cable as 

your default sound device. 

 



Page 22 of 27 

Configuring Your Setup To Start With Windows  

Doing this involves two basic steps: turning your analyzer setup ON and setting Pedalboard2 to start with 

Windows. 

 

1. Turn your analyzer setup ON (see the steps above)  

2. Go to the Windows startup folder: 

 

C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Startup 

 

Keep this window open. 

 

3. Now go to the Pedalboard2 program folder.  

4. Right-click the program file for the version of Pedalboard2 you are using (64-bit or 32-bit). From 

the right-click menu, choose Create Shortcut. 

 

5. Drag and drop the shortcut to the Windows startup folder.  

Pedalboard2 will now start automatically every time you start your PC.   

 
 

Dragging and dropping the Pedalboard2 shortcut from the Pedalboard2 folder (left) to the Windows startup folder (right). 
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When auto-starting, you may also find it useful to 

set Pedalboard2 to start minimized in the 

notification area (near the clock).  

 

From Pedalboard2, go to Options > Misc Settings > 

and tick the options Display Tray Icon and Start In 

Tray. 

 

Although Pedalboard2 will start minimized and not 

show in the taskbar, all plugin windows (such as 

your analyzer) will still be visible.   
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Taking Things To Another Level  

Running Multiple Plugins Simultaneously  

To get a deeper look at what's possible, the screenshot below shows Pedalboard2 and a number of free 

analyzer and metering plugins running simultaneously while a popular streaming service provides the 

audio in the background. All plugins were inserted using the instructions in this guide. 

 

 
 

Clockwise from top left: Voxengo's SPAN (with customized colors and metering); Voxengo's AnSpec (analog bar-style analyzer); Blue Cat's 

FreqAnalyst (with customized colors and metering); IK Multimedia's T-RackS CS Metering (with independent level, RMS, phase, and spectrum 

displays); beyerdynamic's virtual studio (speaker and environment simulator for headphone listening) 

 

A setup like this can be useful for learning about analyzers and deciding which plugin is right for you. You 

could also use multiple analyzers to monitor different aspects of the sound simultaneously. For example, 

you could configure different analyzers (or even multiple copies of the same analyzer) so that some are 

fast, and some are slow; some have frequency smoothing (1/3 octave,1/4  octave, etc.), and some have no 

smoothing (or different smoothing); some are working full-range, while others are focused on specific 

frequency bands or threshold levels. 

 

See the software list in the Downloads section for more info on the free plugins used above.  

Lastly, you can also experiment by adding EQ and compression plugins, to watch how their different 

parameters affect the sound. 
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Adding A Second Display  

For the modest cost of a video cable and a small flatscreen monitor (new or secondhand), or if your 

computer is near a flatscreen TV, you can have all plugins permanently in the foreground on a dedicated 

external screen, while you continue working on your computer's main display. Before purchasing a cable 

or display, check the external display connections supported by your system (HDMI, DVI, VGA, etc.). 

 

 

 

 

Watching SoundGirls videos on a laptop (left) while checking audio on an external display (right). 

 

 

http://www.youtube.com/channel/UCYP0dnGLCUH7rRgasadHM7A
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Basic Troubleshooting  

While advanced system troubleshooting is beyond the scope of this guide, below you’ll find some basic 

tips if you run into trouble. Unfortunately, with Windows especially, there can be a number of 

software/hardware combinations which can impact audio performance. 

 

No Audio  

Incorrect connections are the most likely cause. Go back and double-check the audio settings in Windows 

and Pedalboard2, as well as the virtual cables you drew to connect devices. 

 

To make sure the virtual audio device is enabled on your system, go here.  

To make sure the input and output devices in the plugin host are correct, go here.  

To make sure all devices in your plugin chain are connected correctly inside the plugin host, go here.  

Latency Or Audio Artifacts (Dropouts, Crackling, Etc.)  

In some cases (depending on your hardware and system settings), you may need to do some additional 

investigating to track down issues.  

 

First, you can try adjusting settings in your soundcard’s control panel. Refer to the manufacturer’s 

documentation for assistance. 

 

You can also try adjusting the sample 

rate and audio buffer size from 

Pedalboard2. 

 

Go to Options > audio settings, adjust 

the settings, and re-test.  
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VB-Cable also includes a tool for verifying and adjusting sample rates and latency, the VB-Cable Control 

Panel. 

 

1. Go to the folder where you extracted the 

zip file you downloaded for VB-Cable. 

2. Open the file called 

VBCABLE_ControlPanel. 

 

In addition to real-time stats about the audio passing through your system, the VB-Cable Control Panel 

displays the sample rates and bit depths in use. It also allows you to adjust the internal sampling rate and 

latency. 

 

 

 

For more help on setting up and troubleshooting VB-Cable and using the Control Panel, refer to the 

developer’s help guide: http://vb-audio.pagesperso-orange.fr/Cable/VBCABLE_SystemSettings.pdf 

 

Try The Alternatives From The Downloads Section  

If things still don't improve, refer to the Downloads section above for a list of alternative tools. It's 

possible that another virtual audio device or plugin host will get along better with your particular system.  

 

Technical Support For SoundGirls Members  

Exclusively for SoundGirls members, for additional help send a message to the author through the 

SoundGirls.org members section and post your question in the forum so others can join the discussion.    

 

 

http://www.soundgirls.org/members



